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Top Five Tips 
1. Backup the database regularly!  Microsoft Access© databases can become corrupted 

when the computer crashes. For the most part, they are recoverable with a lot of work, 
but it is ten times easier when it is backed up. 

2. To make the database run faster, compact and repair it on a scheduled basis (once a 
week, once a day, etc).  This command is available under Tools>Database 
Utilities>Compact and Repair Database. 

3. Work your way through Microsoft Access© assistance articles at 
http://office.microsoft.com/en-ca/assistance/CH010422561033.aspx
 
4. Training for Microsoft Access© (in video format)  is available free of charge at: 

 http://office.microsoft.com/en-us/training/CR061829401033.aspx 
 
Other useful sites for learning Microsoft Access© are  

http://databases.about.com/cs/tutorials/a/widgetmenu.htm
http://www.utteraccess.com/

5. Make yourself a backup copy of the database (name it very differently) and experiment 
with queries, etc. It is possible to learn how to use and even develop databases by just 
trying and using your intuition. 

 

1 

http://office.microsoft.com/en-ca/assistance/CH010422561033.aspx
http://databases.about.com/cs/tutorials/a/widgetmenu.htm
http://www.utteraccess.com/


Manual for the Microsoft Access© Database: Print Media Survey Database  
on the 2001 and 2002 Agricultural Drought in Eastern Canada 

 

Overview – Manual 
This manual provides: 

1. Overviews to general Microsoft Access© concepts, objects and functions 
2. Makes reference to Microsoft’s and other’s help files on general concepts, database 

objects and functions; 
3. Specific information/guides to database objects and functions unique to the Print Media 

Survey Database. 
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Overview – Print Media Survey Database 
 The Print Media Survey database contains the full of over 3000 articles related to drought 
impacts and adaptations in Eastern Canada (and some Western Canada articles carried in 
National and Eastern Canada newspapers). 

Each article is coded by keywords describing impacts, adaptations and other identifiers.  
As well it is coded on the geographical location (not necessary the publishing location of the 
periodical) under discussion.  The geographical identifiers are at the country, province, and 
Statistics Canada’s Census Agricultural Regions and Census Division levels.   
 The database also contains over 50 pre-defined queries that generate statistics on 
individually and on combinations of: 

a. Timing: month and year 
b. Occurrence of keywords 
c. Location of articles within the periodical: i.e. number of articles occurring on the front 

page of a newspaper, etc. 
d. Geographical location: Country, province, Census Agricultural Region and Census 

Division 
There is also a form that allows the user to generate their own queries based on timing, 

keyword occurrence, and geographical location. It is also possible to generate a report for printing 
articles as determined by the above query. 
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Database Objects 
1. Database objects refer to method/interface for entering, accessing, storing, manipulating and 

analyzing data in Microsoft Access©.  
2. Microsoft Access© has seven database objects: 

i. Tables 
ii. Queries 
iii. Forms 
iv. Reports 
v. Pages 
vi. Macros 
vii. Modules 

 
3.  Visit http://office.microsoft.com/en-ca/assistance/HP051891361033.aspx for a general 

overview of database design and description of database objects. 
4. The Print Media Survey Database uses five database objects: tables, queries, forms, reports 

and macros that will be discussed in more depth in this manual. 
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Tables 
 Tables are where data is stored.  Tables consist of fields (columns) and records (rows).  
Fields are where a particular type of discrete data is stored i.e., ArticleID, Article Title, Article 
Date, Text of Article, etc.  A record is the complete collection of fields related to a single data 
source.  For example, Table 1 represents a portion of the table tblArticles in the Print Media 
Survey Database. 
 Visit http://office.microsoft.com/en-ca/assistance/CH062526461033.aspx for an overview 
of tables. 
 

Table 1 tblArticles 

ArticleID ArticleDate ArticleTitle Byline Volume Issue PageNumber FrontPage
6616 April 6, 

2001 
What ifs of 
climate change 
becoming reality 

   43 No 

6617 August 21, 
2001 

Lack of rain 
strains crops, 
cattle and people: 
A drought can 
throw careful 
calculations out 
the window 

   B.12 No 

6618 August 21, 
2001 

Conservation 
Authorities get 
cash to deal with 
drought 

The groups 
may use 
some of the 
money to 
police water 
taking from 
area rivers 

  42-43 No 

6619 August 21, 
2001 

Drought sparks 
insurance 
inquiries 

AgriCorp's 
hotline has 
fielded more 
than 2,500 
calls froms 
farmers in the 
past few 
weeks 

  10 No 

 
The highlighted row represents a portion of an entire record.  Unless otherwise specified, 

records in a table appear as rows.  In all most all cases, a record is identified by a primary key (or 
unique identifier).  In the case of tblArticles the unique identifier is the field ArticleID.   

Table 2 identifies the names of tables and their descriptions in the Print Media Survey 
Database. 
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Table 2 List of Tables and Descriptions 
Table Name Descriptions 
tblArticleLNKAuthors This table contains the linkages between articles and authors 
tblArticles This is the main database table containing the singles item fields 

about a document (article) 
tblArticlesLNKCensusAgriculturalRegion This table contains the linkages between Articles and Census 

Agricultural Regions. 
tblArticlesLNKCensusDivision This table contains the linkages between Articles and Census 

Divisions. 
tblArticlesLNKCountry This table contains the linkages between Articles and Countries. 
tblArticlesLNKKeyword This table contains the linkages between Articles and Keywords. 
tblArticlesLNKProvinceState This table contains the linkages between Articles and Provinces and 

States. 
tblArticlesLNKPublications This table contains the linkages between Articles and Publications 
tblAuthors This table contains information about articles’ authors. 
tblCensusAgriculturalRegions This table contains information about Census Agricultural Regions 

(as defined by Statistics Canada) 
tblCensusDivisions This table contains information about Census Divisions (as defined 

by Statistics Canada) 
tblCensusSubDivisions This table contains information about Census SubDivisions (as 

defined by Statistics Canada) 
tblCountry This table contains information about Countries. 

tblKeywords This table contains information about articles’ keywords 
tblKeywordType This table contains information about keyword types 
tblLocality This table contains information about Localities (as defined by 

Statistics Canada). 
tblMainKeyword This table contains information about Main Keyword 
tblMainQueryTypeCode This table contains information about the codes for types of queries. 
tblMunicipalityType This table contains information about Statistic’s Canada municipality 

types. 
tblProvinceState This table contains information about Provinces and States 
tblPublicationLNKCARID This table contains the linkages between Publications and Census 

Agricultural Regions (as defined by Statistics Canada). 
tblPublicationLNKCountry This table contains the linkages between Publications and countries. 
tblPublicationLNKProvince This table contains the linkages between Publications and 

Provinces. 
tblPublicationLNKSubCensusDivision  This table contains the linkages between Publications and Census 

SubDivisions (as defined by Statistics Canada). 
tblPublications This table contains information about documents (articles) 

publications. 
tblPublicationsLNKLocality This table contains the linkages between Publications and Localities  

(as defined by Statistics Canada). 
tblPublicationSource This table contains information about the sources of publications 
tblPublicationType This table contains information about the types of publication 

classifications. 
tblQueryCodes This table contains information about the descriptive codes in query 

names. 
tblQueryNameAndDescriptions This table contains information about individual queries and their 

descriptions. 
tblQueryType This table contains information about the types of queries. 
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Forms 

What are forms? 
 Forms are the main data entry/viewing interface for Microsoft Access©.  There is no 
actual data stored in forms rather they store data in their source tables/queries.   
 The forms available in this database are listed and described in Table 3. The notation for 
forms in this database is frmFormName.  The user will only likely use the main forms for data 
entry and navigation.  Subforms are minor forms that are linked to the main form.  The notation 
for subforms is sbfFormName.  It is unlikely that the user will have any reason to use/or edit 
subforms (except in the context of navigating/editing articles in a main form).  

Table 3 List of Forms in Print Media Survey Database 
Form Name Description 
frmArticles This is the central form that permits entry, editing and navigation of 

articles.  It also contains subforms (sbf*), that link that main article 
information to its additional relevant information (authors, 
publication, keywords, and locations). 

frmArticlesFilteredbyQuery This form permits the querying of articles based on their subform 
data as well as between dates.  

 
frmEnterAuthors This form permits the user to enter authors, either directly by 

opening this form, or through the sbfArticlesLNKAuthors subform 
when an entered author was not previously entered 

frmEnterCensusSubdivisions This form permits the user to enter Census SubDivisions and link 
them to Census Division, Census Agricultural Region, Province and 
Country. 

frmEnterLocality This form permits the user to enter localities and link them to 
Census SubDivisions, Census Division, Census Agricultural Region, 
Province and Country. 

frmKeyword This form permits the user to enter keywords, and link them to a 
main keyword, and keyword type 

frmPublications This form permits the user to enter publications, either directly by 
opening this form, or through the sbfArticlesLNKPublications when 
the entered publication was not previously entered. 

frmPublicationSource This form permits the user to enter the publication source (e.g. 
ProQuest) 

frmQueryNameAndDescriptions This form permits the user to enter or browse queries by names and 
their descriptions 

sbfArticlesLNKAuthors This is a subform of frmArticles that links articles with authors.  It 
should not be opened separately.  

sbfArticlesLNKCAR This is a subform of frmArticles that links articles with Census 
Agricultural Regions  It should not be opened separately. 

sbfArticlesLNKCensusDivision This is a subform of frmArticles that links articles with Census 
Divisions.  It should not be opened separately. 

sbfArticlesLNKCountry This is a subform of frmArticles that links articles with countries.  It 
should not be opened separately. 

sbfArticlesLNKKeyword This is a subform of frmArticles that links articles with keywords.  It 
should not be opened separately. 

sbfArticlesLNKProvinceState This is a subform of frmArticles that links articles with 
provinces/states. It should not be opened separately. 

sbfArticlesLNKPublications This is a subform of frmArticles that articles with publications.  It 
should not be opened separately. 

sbfPublicationLNKCARID This is a subform of frmPublications that links publications with 
Census Agricultural Regions  It should not be opened separately. 

sbfPublicationLNKCountry This is a subform of frmPublications that links publications with 
countries.  It should not be opened separately. 

sbfPublicationLNKLocality This is a subform of frmPublications that links publications with 
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localities.   It should not be opened separately. 
sbfPublicationLNKProvince This is a subform of frmPublications that links publications with 

authors.  It should not be opened separately. 
sbfPublicationLNKSubCensusDivision This is a subform of frmPublications that links publications with 

Census Subdivisions.  It should not be opened separately. 
sbfSwitchboard The switchboard is the main menu/navigation form.  It automatically 

launches when the database is opened 
 

 
Table 4 lists and describes the types of fields present in tables and forms.  The field type 

can limit the type (alphabetic or numeric), format (date), and number of characters entered in a 
field. 

Table 4 List and Description of Field Types 

Field Type Description 
Autonumber This field automatically enters a sequential 

number as new records are entered 
Text Any combination of up to 255 alphanumeric 

characters can be entered in this field 
 

Combo Box This field permits selection from a list of values 
either linked in an another table or within the 
table itself. 

Memo This fields permits entry of an unlimited number 
of alphanumeric characters 

Date/Time This fields permits entry of date in a particular 
format as specified by the programmer 

 

General Data Entry/Navigation Notes 

General 
1. Information can be typed directly in or cut and pasted in each field. 
2. Be sure to enter data in every subform.  If there is no data available, choose none for 

keywords; census division; census agricultural region; province,country and “no author 
listed” for Author.  This helps ensures that queries run properly! 

Navigation 
1. Within the frmArticles you can use the tab key to navigate between fields.   
2. In order to navigate to/between subforms use the mouse and click in the subform you 

want to enter data in. 
3. To find particular text in a field, navigate to the desired field and go to Edit>Find or hit 

Control + F.  Then enter the desired text to find.  If you want to find partially matching 
text, e.g. any variation of  “yield” including “yield, yields”, etc enter “*yield*”.  The asterisks 
around yield are known as wildcards.  You should also use wildcards around the desired 
find term, if you looking for a term that will be surrounded by other text, as in the case of 
fulltext. 

4. You can not use the Find function within subforms of a main form.   

Using Macros 
 Macros are “shortcuts” programmed to execute certain common tasks.  Table 5 lists and 
describes how to use the pre-programmed macros for common tasks within forms within the Print 
Media Survey Database. 
 

8 



Manual for the Microsoft Access© Database: Print Media Survey Database  
on the 2001 and 2002 Agricultural Drought in Eastern Canada 

Table 5 List of Macros 
AutoKey Function 
Control + L Lookup Locality or Census Subdivison 
Control + N Go to Next Record 
Control + P Go to Previous Record 
Control + R Remove Filter 
Control + U Unhide Columns 
Control + Q Open Query Codes and Descriptions 

Filters 
1. Filters allow you to choose text within a record and find all records with the chosen text.   
2. To filter a record, highlight the desired text with the mouse and right click and choose 

>Filter by Selection. 
3. This will result in only the records with the chosen text being retrieved. 
4. To remove a filter either go to: 

Records>Remove Filter/Sort 
OR 
Use the Macro: Control + R 

5. The most likely use of filters within frmArticles is to choose text in the Fulltext field.  For 
example, if you want to find all articles with the term “conservation authority” in the full 
text, first follow the steps to find text as described in the Navigation Section 3 above.  
Then highlight the “conservation authority” in the Fulltext field, right click and 
choose>Filter by Selection.  This should retrieve only articles with the term 
“conservation authority in the Fulltext field” 

6. You can not use the Filter function within subforms of a main form.   
 

Form Specific Notes 
frmArticles 

1. The form frmArticles is the main entry form for articles 
2. The table below provides descriptions / instructions for the fields  

Field Name Field Type Description/ Instructions 
 (Article)ID Autonumber This is an autonumber field that is the unique identifier for each 

article.  As soon as you start to enter data in another field, 
Access will autofill this field with a unique number.  You can use 
this number to search for an article.  As well, this number links 
the articles to other relevant information (Authors, Publication, 
Geographical Identifiers) 

ArticleDate Date Enter the date in the format mm/dd/yyyy or Month day, year 
e.g.November 5, 2001.  If you enter in the mm/dd/yyyy format, 
Access will convert it to the Month day, year format. 

Volume Text Enter the volume number if relevant 
Issue Text Enter the Issue number if relevant 
Page Text Enter the page(s), e.g. 43; A.7-A.8; or 43-45 & 47 
FrontPage Text Enter either Yes OR No.  Identify an article as FrontPage if the 

article appears on pg. 1 or A.1  
ArticleTitle Text Enter the lead title for the article 
Byline Text Enter any supplementary titles for the articles 
URL Memo Enter the URL of the article if relevant 
Copyright Text Enter the copyrighted sources of the article e.g., Bell 

GlobeMedia 
Dateline Text Enter the dateline for the article, e.g. Halifax, N.S.- 
Full Text Test Enter the fulltext of the article, either directly or by cutting and 

pasting from another source 
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sbfArticlesLNKAuthors (called Authors) 
1. This subform allows you to link authors to articles.  To add an author to an article, start 

typing the name, in the AuthorId field, last name first.  This will bring up a list of authors 
already in the Authors table.  If it brings up the author you are looking for, hit enter to add 
it.  If it is not bringing up the desired author, finish typing the last name of the author you 
want, and hit enter.  This will cause a pop-up to say “This author is not in list.  Add it?”.  
Choose yes, and this will bring up an entry form called qryLookupAuthors.  Do not enter 
anything in the field AuthorID or FullName (this field will autocomplete).  Type in the 
AuthorLastName and AuthorFirstName and close this box by hitting the X in the upper 
right corner of the entry form.  This will return to you to frmArticles and the author you 
enter should be present in the Authors subform (you may have to scroll up to see this). 

 
sbfArticlesLNKPublications (called Publications) 

1. This subform allows you to link publications to articles.  To add a publication to an article, 
start typing the publication name.  This will bring up a list of publications already in the 
Publications table.  If it brings up the publication you are looking for, hit enter to add it.  If 
it is not bringing up the desired publication, finish typing the publication name you want, 
and hit enter.  This will cause a pop-up to say “This publication is not in list.  Add it?”.  
Choose yes, and this will bring up an entry form called sbfPublications. Do not enter 
anything in the field PublicationID. Complete at least the Publication Name field, and any 
additional fields that are appropriate. 

2. Close this box by hitting the X in the upper right corner of the entry form.  This will return 
to you to frmArticles and the author you enter should be present in the Publications 
subform (you may have to scroll up to see this). 

 

Geographical Classification 
1. If you do not know the census division, census agricultural region, etc. for a particular 

city, town or village, enter Control+L and enter the name of the place you are looking for 
with wildcards on both sides, e.g. *Smiths Falls*.  This will locate the Census Division, etc 
for you.   

 
sbfCensusDivision 

1. This subform allows you to link Census Division to articles.  To add a Census Division to 
an article, start typing the Census Division name.  This will bring up a list of Census 
Divisions in tblCensusDivisions.  This will bring up a list of Census Divisions that start 
with the characters you have typed.  It is very common for there to be multiple Census 
Divisions with the same name in very different locations.  Be sure to use the one that 
matches up with the province you are referring to.  Hit enter to enter the desired Census 
Division.   

2. If you want to enter multiple Census Divisions, hit tab to go to the next line and enter the 
next Census Division. 

3. As this database contains all the relevant Census Divisions for Canada, you will need to 
enter additional Census Divisions.  If you can not locate the Census Division you are 
interested in, please check the spelling and look again. 

 
sbfCensusAgriculturalRegions 

1. This subform allows you to link Census Agricultural Region to articles.  To add a Census 
Agricultural Region to an article, start typing the Census Agricultural Region name.  This 
will bring up a list of Census Agricultural Regions in tblCensusAgriculturalRegions.  This 
will bring up a list of Census Agricultural Regions that start with the characters you have 
typed.  It is very common for there to be multiple Census Agricultural Regions with the 
same name in very different locations.  Be sure to use the one that matches up with the 
province you are referring to.  Hit enter to enter the desired Census Agricultural Region.   

2. If you want to enter multiple Census Agricultural Regions, hit tab to go to the next line 
and enter the next Census Agricultural Region. 
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3. As this database contains all the relevant Census Agricultural Regions for Canada, you 
will need to enter additional Census Agricultural Regions.  If you can not locate the 
Census Agricultural Region you are interested in, please check the spelling and look 
again. 

 
sbfProvinceState 

1. This subform allows you to link Provinces or States to articles.  To add a Provinces or 
State to an article, start typing the Provinces or State name.  This will bring up a list of 
provinces or states in tblProvinceState.  This will bring up a list of provinces and states  
that start with the characters you have typed.  Hit enter to enter the desired province or 
state. 

2. If you want to enter multiple provinces or states , hit tab to go to the next line and enter 
the next province or state.  

3. As this database contains all the provinces (Canada) and states (United States), you 
should not need to enter any more. 

sbfCountry 
4. This subform allows you to link countries to articles.  To add a country to an article, start 

typing the country name.  This will bring up a list of country in tblCountry.  This will bring 
up a list of countries that start with the characters you have typed.  Hit enter to enter the 
desired country. 

5. If you want to enter multiple countries, hit tab to go to the next line and enter the next 
country  

6. The tblCountry contains three options for countries:  Canada, United States or None.  If 
you wish to enter further countries, add them to tblCountry. 

Keyword Classification 
1. The subform to enter keyword for articles is sbfArticlesLNKKeywords.   
 

sbfArticlesLNKKeywords 
1. If a keyword in an article is related to the effects of drought e.g. diminished crop yield of 

corn due to drought.  
Enter the keywords: 

a. Corn 
b. Drought 
c. Diminished crop yield 

2. To enter these keywords, start typing the keyword in the KeywordID field.  This will bring 
up a list of keywords that start with the characters you have typed. Hit enter to select the 
desired keyword. 

3. It is very possible that there may be keywords very similar in name, be sure you are 
selecting the correct one.  For example if you enter vegeta, the first term you bring up will 
be “vegetables”, but if you scroll one down it will be “vegetative buffers” 

Other Key Forms 
frmArticlesFilteredbyQuery 

1. This form is identical to frmArticles however when you open it prompts you to enter a 
query for the following: 

a. Country:  Enter either Canada OR United States.  If you are interested in both 
enter *. 

b. CAR (Census Agricultural Region):  Enter the Census Agricultural Region you 
are interested in.  If you are interested in all CARs enter *. 

c. Province (Province or State):  Enter the Province/State you are interested in.  If 
you are interested in all province/states enter *. 

d. Census Division:  Enter the Census Division you are interested in.  If you are 
interested in all Census Divisions enter *. 
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e. Keyword: Enter the Keywords you are interested in.  If you are interested in all 
Keywords Divisions enter *. 

f. Beginning date: Enter the start date of articles in mm/dd/yyyy format. You must 
enter a date or the query will not work properly. 

g. End date:  Enter the end date of articles in mm/dd/yyyy format. You must enter a 
date or the query will not work properly.  

 
frmPublications 

1. The table below provides descriptions / instructions for the fields  
Field Name Field Type Description/ Instructions 
 PublicationID Autonumber This is an autonumber field that is the unique identifier for 

each Publication.  As soon as you start to enter data in 
another field, Access will autofill this field with a unique 
number.  You can use this number to search for an article.  
As well, this number links the articles to other relevant 
information ( Geographical Identifiers) 

PublicationName Text Enter the name of the publication. 
PublicationType ComboBox Enter the publication type (combobox source: 

tblPublicationType), i.e., Agricultural Community Publication, 
Provincial/Regional/Local Newspaper, etc. 

PublicationSource ComboBox Enter the publication source (combobox source: 
tblPublicationSource), i.e., hardcopy, Proquest, etc. 

PublicationURL Memo Enter the publication URL (if available) 
 

2. This form permits the entry of publications and linking them to geographical 
classifications.  The process for linking geographical classifications to publications is 
almost identical to that for linking articles with geographical classifications, except there is 
no classification by Census Division, but rather Locality and Census SubDivision. 
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Queries 

General 
1. Queries are just that, querying data according to specific criteria, e.g. range of dates, by 

keywords, appearance of a word in full text, etc. 
2. The main way for designing queries is with SQL (Structured Query Language), 

pronounced sequel .You can create queries with only a basic knowledge of SQL in 
design view (the visual interface for creating queries), but being able to write SQL greatly 
expands the complexity of queries you can write, and increase the usefulness of your 
data. 

3. You should work through the Microsoft Access© tutorial Get Answers with Queries for an 
overview of how queries work.  It is available at: 

http://office.microsoft.com/training/training.aspx?AssetID=RC010776611033
 

Queries Available 
1. The names and descriptions of the queries available are stored in Forms: 

frmQueryNameAndDescriptions and Tables: tblQueryNameAndDescriptions.  Table 6 
below duplicates tblQueryNameAndDescriptions. 

Table 6 List and Descriptions of Queries 

Query Name Query Description Query Type 
qry01All 2001 record source; all Source 
qry02All 2002 record source; all Source 
qry02CarId 2002 records with 2001 drought” but without 

“Current drought year” and excluding other 
unwanted keywords with counts by Census 
Agricultural Region 

Record Count 

qry02Id 2002 record source with the keyword “2001 
drought” ”, excluding “Current drought year” and 
excluding other unwanted keywords with counts 

Source 

qry02KwId 2002 record count by keywords; with the 
keyword “2001 drought” but without “Current 
drought year” and excluding other unwanted 
keywords with counts 

Record Count 

qry02KwPrId 2002 record count by keywords and province; 
with the keyword “2001 drought” but without 
“Current drought year” and excluding other 
unwanted keywords with counts 

Record Count 

qry02KwPrIdOp 2002 record count by keyword and by Eastern 
Provinces (Ontario, Nova Scotia, New 
Brunswick and Prince Edward Island); with the 
keyword “2001 drought”, but without “Current 
drought year” and excluding other unwanted 
keywords 

Record Count 

qry02MtId 2002 record count by keyword main type; with 
the keyword “2001 drought” but without “Current 
drought year” and excluding other unwanted 
keywords with counts 

Record Count 

qry02MtPrId 2002 record count by keyword main type and 
province; with the keyword “2001 drought” but 

Record Count 
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Query Name Query Description Query Type 
without “Current drought year” and excluding 
other unwanted keywords with counts 

qryAEk Record count by year; excluding unwanted 
keywords 

Record Count 

qryAEw Record count by year; excluding the keyword 
“Exclusively East West” 

Record Count 

qryAllDates Retrieves records by date Source 
qryAllSubFrmsDate Source query for frmArticlesFilteredbyQuery Source 
qryAnnum Retrieves all records and identifies their year Source 
qryArticlesbyAuthors Counts the number of records by authors Record Count 
qryArticlesLNKAuthors Source query for sbfArticlesLNKAuthors Source 
qryArticlesLNKCAR Source query for sbfArticlesLNKCAR Source 
qryArticlesLNKCensusDivis
ion 

Source query for sbfArticlesLNKCensusDivision Source 

qryArticlesLNKCountry Source query for sbfArticlesLNKCountry Source 
qryArticlesLNKKeyword Source query for sbfArticlesLNKKeyword Source 
qryArticlesLNKProvinceStat
e 

Source query for sbfArticlesLNKProvinceState Source 

qryArticlesLNKPublications Source query for sbfArticlesLNKPublications Source 
qryArticlesWithoutMatching
ArticlesLNKCensusAgricult
uralRegion 

Check query for matching 
ArticlesLNKCensusAgriculturalRegion 

Check 

qryArticlesWithoutMatching
ArticlesLNKCensusDivision 

Check query for matching 
ArticlesLNKCensusDivision 

Check 

qryArticlesWithoutMatching
ArticlesLNKCountry 

Check query for matching ArticlesLNKCountry Check 

qryArticlesWithoutMatching
ArticlesLNKKeyword 

Check query for matching ArticlesLNKKeyword Check 

qryArticlesWithoutMatching
ArticlesLNKProvinceState 

Check query for matching 
ArticlesLNkProvinceState 

Check 

qryCAR Source query for qryAllSubFrmsDate Source 
qryCarA Record count by Census Agricultural Region Record Count 
qryCarAEk Record count by Census Agricultural Region 

and year; excluding unwanted keywords 
Record Count 

qryCarAId Record count by Census Agricultural Region 
and year; including "2001 drought" without 
"current drought", excluding other unwanted 
keywords 

Record Count 

qryCdAAll Record count by census division and year; all Record Count 
qryCdAEk Record count by census division and year; 

excluding unwanted keywords 
Record Count 

qryCensusDivision Source query for qryAllSubFrmsDate Source 
qryCensusSubDivision Source query for qryPublicationPlace Source 
qryCensusSubdivisionsWit
houtMatchingLocality 

Check query 
CensusSubDivisionsWithoutMatchingLocality 

Check 

qryCountry Source query for qryAllSubFrmsDate Source 
qryEastWest Record source including "East-West Transfer" Source 
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Query Name Query Description Query Type 
qryEk Record source excluding unwanted keywords Source 
qryEkMa Record count by month/year; excluding 

unwanted keywords 
Record Count 

qryEw Records excluding the keyword “Exclusively 
East West” 

Source 

qryExcludeEastWest Record source excluding they keyword “East-
West Transfer” 

Source 

qryExcludeExclusivelyOut
West 

Record source for qryEw Source 

qryExcludeHayWest Record source without they keyword “Hay 
West” 

Source 

qryExcludeUnwantedKeyw
ordsExcept2001Drought 

Record source without the unwanted keywords 
but including 2001 drought 

Source 

qryExcludeUnwantedKeyw
ordsIncluding2001Drought 

Records source without the unwanted keywords 
excluding 2001 drought 

Source 

qryExclusivelyOutWest Record source with the keyword “Exclusively 
Out West” 

Source 

qryFindduplicatesfortblLoca
lity 

Find duplicate localities Duplicate 

qryFpMaAll Front page record count by month/year; all Record Count 
qryFpMaEk Front page record count by month/year; 

excluding unwanted keywords 
Record Count 

qryFpMaId 2002 Front page record count by month/year, 
with the keyword “2001 drought” ”, excluding 
“Current drought year” and excluding other 
unwanted keywords 

Record Count 

qryFpPrAAll Front page record count, by province and year; 
all 

Record Count 

qryFpPrAEk Front page record count by province and year; 
excluding unwanted keywords 

Record Count 

qryFpPrAId Front page record count, by province and year; 
including “2001 drought”, but without “Current 
drought year” and excluding other unwanted 
keywords 

Record Count 

qryFpPrMaAll Front page record count by province and 
month/year; all 

Record Count 

qryFpPrMaEk Front page record count by month/year and 
province, excluding unwanted keywords 

Record Count 

qryFulltext Source query for qryAllSubFrmsDate Source 
qryId Record source with the keyword including “2001 

drought”, but without “Current drought year” and 
excluding other unwanted keywords 

Source 

qryIdMa Record count by month/year; including "2001 
drought" without "Current drought year" and 
excluding unwanted keywords 

Record Count 

qryKeyword Source query for qryAllSubFrmsDate Source 
qryKeywordMasterList List of all keywords sorted by main keyword 

name, keyword main type and keyword 
Source 

15 



Manual for the Microsoft Access© Database: Print Media Survey Database  
on the 2001 and 2002 Agricultural Drought in Eastern Canada 

 

Query Name Query Description Query Type 
qryKwAAll Record count by keyword and year; all Record Count 
qryKwAEk Record count by keyword and year; excluding 

unwanted keywords 
Record Count 

qryKwAEkOp Record count by year; of all Eastern Provinces 
(Ontario, Nova Scotia, New Brunswick and 
Prince Edward Island), excluding unwanted 
keywords 

Record Count 

qryKwAId Record count by keyword and year; including 
"2001 drought" without "Current drought year" 
and excluding unwanted keywords 

Record Count 

qryKwAll Record count by keyword; all Record Count 
qryKwPrAAll Record count by keyword, province, year; all 

records 
Record Count 

qryKwPrAEk Record count by province, keywords and year, 
excluding unwanted keywords 

Record Count 

qryKwPrAId Record count by keyword, province and year; 
including "2001 drought" without "Current 
Drought", excluding unwanted keywords 

Record Count 

qryLocality Source query for qryLookupPlace Source 
qryLookupAuthors Source query for sbfArticlesLNKAuthors Source 
qryLookupCAR Source query for sbfArticlesLNKCAR Source 
qryLookupCensusDivision Source query for sbfArticlesLNKCensusDivision Source 
qryLookupCensusSubDivisi
on 

Source query for qryLookupPlace Source 

qryLookupKeyWord Source query for sbfArticlesLNKKeywords Source 
qryLookupPlace Source query for mcrLookupPlace Source 
qryLookupProvince Source query for sbfArticlesLNKProvince Source 
qryMaAll Record count by month and year; all Record Count 
qryMaEk Record count by month/year; excluding 

unwanted keywords 
Record Count 

qryMonth Source query for other queries requiring a 
month/year field 

Source 

qryMtAEk Record count by keyword main type and year, 
excluding unwanted keywords 

Record Count 

qryMtAEkOp Record count by keyword main type and year; 
of all Eastern Provinces (Ontario, Nova Scotia, 
New Brunswick and Prince Edward Island), and 
excluding other unwanted keywords 

Record Count 

qryMtAIdOp Record count by keyword maintype and year; of 
all Eastern Provinces (Ontario, Nova Scotia, 
New Brunswick and Prince Edward Island), with 
the keyword “2001 drought” but without “Current 
drought year” and excluding other unwanted 
keywords 

Record Count 

qryMtKwAAll Record count by keyword main type and year; 
all 

Record Count 

qryMtPrAEk Record count by keyword main type, province 
and year; excluding unwanted keywords 

Record Count 
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Query Name Query Description Query Type 
qryPlace Record source for qryLookupPlace Source 
qryPrAAll Record count by province and year; all Record Count 
qryPrAEk Record count by province and year; excluding 

unwanted keywords 
Record Count 

qryPrAId Record Count by province and year; including 
"2001 drought" without "Current drought" and 
excluding unwanted keywords 

Record Count 

qryPrAll Record count by province; all Record Count 
qryPrEk Record count by province; excluding unwanted 

keywords 
Record Count 

qryPrMaAll Record count by province and month/year; all Record Count 
qryPrMaEk Record count by province and month/year; 

excluding unwanted keywords 
Record Count 

qryProvince Source query for qryAllSubFrmsDate Source 
qryPt Record count by publication type Record Count 
qryPtAll Record count by Publication Type; all records Record Count 
qryPtEk Record count by Publication Type; excluding 

unwanted keywords 
Record Count 

qryPublicationbyCAR Source query for qryPublicationPlace Source 
qryPublicationbyCensusSu
bDivision 

Source query for qryPublicationPlace Source 

qryPublicationbyCountry Source query for qryPublicationPlace Source 
qryPublicationbyProvince Source query for qryPublicationPlace Source 
qryPublicationCensusSubD
ivision 

Source query for qryPublicationPlace Source 

qryPublicationCountbyProvi
nce 

Publication count by province Record Count 

qryPublicationLocality Source query for qryPublicationPlace Source 
qryPublicationPlace List of all publications sorted by place 

(locality/census subdivison), Census 
Agricultural Region, Province and Country 

Source 

qrySourceExcludeUnwante
dKeywordsExcept2001Dro
ught 

Source query for qryId Source 

qrySourceforId Source query for qryId Source 
qryUnionPublicationPlace Source query for qryPublicationPlace Source 
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As there are over 50 queries in the Print Media Survey Database, it was necessary to 
develop short form naming conventions.  Table 7 identifies the codes and their descriptions, and 
how the codes should be ordered (Query Code Rank).  For example Fp or Pt (1), should appear 
first in a query name, followed by Mt(2), then by Kw (3) and so on. 

Table 7 Query Codes (Naming Conventions) 

Query Code 
Abbreviation Query Code Name/Descriptions 

Query 
Code 
Rank 

Mt Keyword Main Type 2
Kw Keyword 3
Pr Province 4
Car Census Agricultural Region 5
Cd Census Division 6
A Annum (Year) 7
Ma Month/Annum 8
Id Includes records with keyword "2001 drought" but not with 

keyword "Current drought", excludes records with other 
unwanted keywords 

9

Ek Excludes unwanted keywords 9
Op Only includes provinces under analysis (Ontario, Nova Scotia, 

New Brunswick and Prince Edward Island), 
10

Fp Front page 1
All All record 9
Od Source for Id 0
Pt Publication Type 1
 
 

Table 8 identifies the different types of queries and their functions.   

Table 8 Query Types 

Query Type Description 
Source This type of query will bring up a list of records, normally a list of unique 

identifiers, i.e., ArticleID and related fields, i.e, ArticleDate, ArticleTitle, etc. 
according to specified criteria. 

Record Count This type of query reports on the number of unique identifiers (normally 
ArticleIDs or PublicationIDs) that match specified criteria, e.g., date range, 
containing one or more keywords, etc. 

Duplicate This type of query retrieves records (normally Articles) that contain identical 
information in one or more fields, e.g. ArticleTitle, FullText, etc.  This allows to 
you retrieve and delete duplicate records if desired. 

Running Queries and Viewing Results 
1. To run a query, double click on it. 
2. This will open up a new window and bring up the results.   
3. Most record count queries can be viewed in what is called PivotTable View.  This permits 

easy organization of query results and formatting. It also allows you to export the results 
to Microsoft Excel© for further formatting. To open PivotTable View, open a query as 
indicated above and go to View> PivotTable View. Visit http://office.microsoft.com/en-
ca/assistance/HP030843861033.aspx to learn how to create and change PivotTables. 
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Reports 
 Reports permit the arrangement of results of queries or fields from one or more tables in 
a visually attractive manner that is formatted for printing.  The Print Media Survey Database has 
one report: rptArticles.  This report will print one or multiple articles on an individual basis based 
on input to the query qryAllSubFrmsDate.   

1. To run qryAllSubFrmsDate, double click on it and respond to the query prompts. 
2. For further information on creating Reports, visit http://office.microsoft.com/en-

ca/assistance/HP051872981033.aspx 
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Summary 
 The Print Media Survey Database is a powerful tool for entering data about all types of 
periodical documents, coding these documents by keywords, and analyzing this data by 
geographical, keyword, timing and front page positioning criteria.   
 The document LIMITED TECHNICAL REPORT-Canadian Droughts of 2001 and 2002: 
Print Media Survey of the Eastern Canadian Droughts of 2001 and 2002 provides further 
information on the criteria for document selection and coding. 
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